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Chapter 1
INTRODUCTION TO MAPLE

Maple is a computer algebra system developed in Canada, initially at the University of
Waterloo. It is now owned and developed by a company called Maplesoft. Maple runs on a
number of operating systems, including Microsoft Windows, Mac and Linux. The current
version of Maple is Maple 2017 and this version is installed in the School of Mathematics
and Statistics labs and also available from the bookshop if you wish to buy a copy for
your own use. In the School's labs, we have customised the settings of Maple. If you have
your own copy of Maple, you should read sectidn 3.2 that explains how to apply the same
settings to your copy.

These Notes cover what you need to know about Maple in MATH1131/1141 and
MATH1231/1241. They are also useful for other Maple based rst year courses, but cover
more material than is required. In addition, there are a number of Maple lessons available
on Moodle, see section 1.6.

If you want to know more, there is lots of information in Maple's in built help, on the
web or in the many books on Maple | some of them are listed in sectioh 2.24.

1.1 What Does Maple Do?

A calculator (or a computer with numerical computation software) can do things like
evaluating a function at a point 7

nd an approximate value for ade nite integral like X sin(x) dx,
0

but it EANNOT tell you that

x sin(x) dx = sin(x)  x cosk)

dX X
—x* = x*(1 +
dxX x*(1+1In x)

the exactroots of x> 2x 2 are 1 p§. 0
the solution of ageneralquadratic ax®>+ bx+ cis ( b ¥ 4ac)=2a

Maple can do ALL these things | and much more as well. The following list shows just a
few (in fact a small fraction) of the things which Maple can do. (Some of these are things
which you will not understand now, but you will by the end of the year.)

di erentiate functions;

nd inde nite integrals for many functions;

evaluate many complicated limits;

nd exact solutions for many algebraic equations, including some with arbitrary
coe cients;

perform algebraic operations on polynomials and rational functions;

plot graphs of functions of one or two variables;

solve many classes of di erential equations;

1
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Figure 1.1: Maple in the Red-Centre labs

perform linear algebra operations, such as multiplying matrices.

In addition, it can link to other applications and be used to create interactive docu-
ments.

1.2 The Maple Window

This chapter (and chapter| 2) will tell you as much about Maple as you need to know
in order to complete your rst year Maple assessments.

In your rst year mathematics courses you will use Maple via its Graphical User
Interface (GUI). To start Maple click on the Maple Application Icon in the task bar (as
described in the lab notes). After some time, a Maple window, similar to that shown in
gure [T, will appear. Note that the window shown is Maple in the Red-Centre labs. If
you have your own copy of Maple it will appear slightly di erent. For more details, see
Chapter 3.

To open a blank Maple worksheet, click on the \New Worksheet" tile that is the second
from the left in the top row of tiles. Figure[1.2 shows the Maple window with a blank
Maple worksheet open in the second tab. This window contains

a menu bar across the top with menus:

File E dit View | nsert For mat...... Tools Window Help

some of which are described below;

a tool bar immediately below the menu bar, with button-based shortcuts to com-
mon operations;



1.2. The Maple Window

Figure 1.2: Maple in the Red-Centre labs

3



4 CHAPTER 1. INTRODUCTION TO MAPLE

1.3 Using an Maple Worksheet

For an online or laboratory Maple test you will need to create and save a Maple
worksheet that you will use for solving the problems we give you. Commands are typed
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Figure 1.3: A Maple Worksheet

If you press<Enter> without typing a colon or semicolon, Maple will warn you, insert
a semi-colon itself and try to execute your commani it looks complete to Maple This
may be what you want but it might not be, so you have to be careful. If the command
does not look completed, (for example you are using a loop, see 2.20) then you will get a
warning message like

Warning, premature end of input, use <Shift> + <Enter> to avoid this message.
which you can ignore if you want and continue with the command. Thus yowan
enter commands too long to t on a line (for example, a large matrix). Just press
<Shift>- <Enter> at a convenient point (such as the end of a column of the matrix
| but NOT in the middle of a word or number) and continue on the next line.

Exercise  If you have not already done so, start Maple. Type the following commands
(you may omit the words after the# on each line). After each command, press
<Enter> and wait for the result to appear before entering the next command.

diff(x"3,x); # a derivative
int(x"2*sin(x),x); # an integral
solve(x"2-2*x-2,X); # roots of a quadratic
limit((3*x+4)/(5*x+6),x=infinity); # a limit as x goes to infinity
The results you get from this exercise should be:
3x2

x? cos) + F2> cos(x) + 2 x sin(x)
1+
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means the last result that Maple calculated anchot the previous result on the screen |
they can be di erent. Similarly you can use%% for the result before last(i.e. the second
last result), and %%% for the one before that(i.e. the third last result). You cannot go
further back than that using %. For example, the sequence of commands

diff(tan(x),x);

diff(%,x);
will give you the secondderivative of tanx . Try it (and note that the derivative of tan x
is not expressed in exactly the way that you might have expected).

1.3.4 Context Sensitive Menus

Another way of using a previous result is provided by theontext sensitive menus
If you right-click on an object in the worksheet (such as a plot, or the result of a command)
a menu opens up allowing you to operate on that result. Exactly what you can do depends
on the result, which is why they arecontext sensitive Several of the options have sub-
menus.

For example, with a plot the menu will allow you to change the plotting style, the
axes, the colours (if a 3-d plot) etc and to output the plot in one of several di erent forms.

If you have an expression, such as, sa§o<3 then right clicking on it will allow you to
choose to do several things to it, such as assign it to a name, di erentiate or integrate it,
evaluate it or nd its zeros.

With a matrix, you get the option to apply many commands from theLinearAlgebra
package (see section 2]12). Note that Maple uses the full name of the commands from
packages.

Using these menus can save a lot of e ort. However, in a rst year Maple Lab Test,
you need to make sure that you use typed Maple commands so that the marker can see
how you have used Maple commands to obtain the result.

1.3.5 Aborting Commands
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1.3.7 Changing Maple Commands

Sometimes you will need to change a command that you have already entered. To do
so, move the Maple | cursor to the place where you want to make a change by clicking
the left mouse button there (or by using the arrow keys). Then

the Delete key deletes the character to theight of the cursor
the Backspace key deletes the character to thdeft of the cursor

and you can insert new characters at the position of the cursor.

When you have changed a command and want to execute the changed command,
make sure that the | cursor is (anywhere) on the line of that command and then press
<Enter>. The result of the changed command should appear on the screen, replacing
the previous result.

Note: If the command you changed use& to refer to results of previous commands
then you will have to go back and re-execute those commands (by moving the cursor to
each of those command lines and pressidgnter>) before you execute the command you
changed. This is becausé refers to the result ofthe command most recently executed
by Maplewhich is NOT necessarily the one on the line above the cursor's position.

Also, if the previous results of the command you changed were used in aupsequent
commands then these later commands will have to be executed again. To be safe, it is
best to press<Enter> on every command line which comes after any command line that
you have changed.

If you want to insert a whole new command among previous commands, move the
cursor to the execution groum%714.44546.diterl

[ ]
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1.4 Saving a Maple worksheet

A Maple worksheet can be saved and re-opened at a later time in much the same way
as other kinds of documents such as word processer documents or spreadsheets. Saving a
Maple worksheet preserves only what you see in the worksheet. When this worksheet is
re-opened, Maple will not remember and variables you may have de ned, packages loaded
or the results of recently executed Maple commands. This will be become clearer once
you have used Maple.

A Maple worksheet can also be exported into other formats such as html, i. e. as a
webpage, or as a text le containing only the Maple commands.

It is strongly recommended that you save a Maple worksheet regularly while you are

using it.
There are two ways tosaveyour worksheet. You can either click on the Save Icon
(picture of a oppy disk) or select either theSave or the Save A ... option from the

File menu. If you selectSave or click the Save Icon and the active worksheet has a
name, it will be saved s a workshegtin a le with that name; if it has no name, you

get the Save As dialogue box. So you can save an updated version of the same session
in a le with the same namesimply by clicking on the Save icon: If you wish to save it

with a new name, you will need to select th&ave A ... from the File menu.
SelectingSave A ... will always bring up the Save As Dialogue Box. At the
]
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Input (.mpl) and then enter the name of the le in theFile N ame box. If the le does
not have the .mpl extension that designates a Maple Input le then Maple will add one.
If there is already a le with that name, you will be asked to con rm the name and if you
do the old le will be overwritten.

1.5 Maple On-line Help

Maple has built in help that can be accessed from thidelp menu. A menu appears
looking like this:

Maple Help Ctrl-F1
Take a Tour of Maple

Quick Reference Ctrl-F2

Manuals, Dictionary, and more.

On the Web
About Maple. ..

If you select Maple Help from this menu, a new window will appear. In theight
hand section of this window is some text entittedMaple Resources . This window also
has severahyperlinksindicated by underlinedtext.

The left hand section of this window is the Help Browser, which will show the Maple
Help Navigator expanded as far as the help page visible in the right hand panel.

1.5.1 The Help Browser

To learn how to use the help browser, click on the élp and move your mouse down
to the line \Manual

[]
L]
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Figure 1.4. Maple Help Browser

For example, with \Text" selected, a search on \di erentiation" gives you a lot of pages;
using \Topic" just two help pages and the dictionary de nition page.

If you had selected a help page using tH2 (see below) then the \Search Results" tab
is open, and lists all the results of a search on your input text.

You can change the relative width of the two panels in the help page by dragging the
left boundary of the right panel with the mouse.

1.5.2 Using the Results

The Help Navigator and Search Result panels use dierent icons to tell you about
the pages. An icon shaped like a folder tells you that there are subpages (or subfolders)
collected under that heading: clicking on a line with a folder icon opens up the subfolders
and pages.

A question mark designates a help page: clicking on that opens an actual help page in
the right hand side. A letter \D" in a yellow square links to a dictionary de nition page.
Both of these open in the right panel of the Help Browser.
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The help pages start with a formal statement of the “syntax' of the command (i.e. de-
tails of how to enter it). This may be hard to understand, but at the end of the entry

will be some examples of usage. Use the scroll bar to move through the entry until you
get to the examples.

Exercise  Use a topic search to nd the help entry for the integration commandint
and read through it trying to understand it. Use the mouse to highlight one of the
example command lines from the end of this entry and press Ctrl > -C to copy






Chapter 2
MAPLE COMMANDS AND LANGUAGE.

This chapter, which contains details of the Maple commands and language, is qu3GE.

[]
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Maple you can easily nd 1000! because Maple can handle integers of almost any size.
Try nding 1000!, but do not get carried away with calculating factorials because they get
very large very quickly and can easily lead you to exceed your time and memory limits.

Unlike most calculators and most computer programming languages, Maple does all
arithmetic EXACTLY, i.e. as rational numbers (fractions with numerator and denomina-
tor having as many digits as is necessary) or as surds or as roots of equations. The only
exception is when you deliberately enter numbers as decimals.

If you want to evaluate a fraction as a decimal number, use the commarevalf
(‘evaluate as oating point). This will normally display the answer to 10 signi cant
digits (although it uses more than 10 digits internally when doing its calculations). If you
want to use a di erent number of digits for all your displays of decimal numbers, use the
commandDigits to set the required number. For example, enter

Digits := 50;
to tell Maple that you want all oating point results displayed to 50 signi cant digits. If
you only want to display one number to a di erent number of digits (without changing
the number of digits for all displays), you can include the number of digits in thevalf
command itself. For example,

evalt(1/17,50);
will evaluate 1=17 to 50 signi cant digits.

There are several ways to enter a decimal or " oating point' number. For example,
67:2319 can be entered a87.2319 or 0.672319*10/2 or 672319*10™(-4) etc, orin
the form Float(672319,-4)  which stands for 672319 10 #. Note that this always
has the form

Float(integer,integer);

There are limits to the size of the second integer (which speci es the exponent) and
the number of digits is governed by the value of the variabIBigits .

Anything which is entered as a oating point number will stay as a oating point
number and will not be converted to a fraction unless you specically ask Maple to
convert it into a fraction. To do that, use the convert command as in

convert(%,fraction);
Arithmetic done on oating point numbers will always give a oating point answer.

2.2 Variables: Assignment and Unassignment.
2.2.1 Assigning

You can assign any expression to a variable for further use, as was done in segtioh 1.3
with the command
T = sin(X);
This assigns the current “value' of the expressiasin(x) to the variable f. If X is an
unknown, as was the case in Chapter 6, theh stands for the expression sir and we
can, for example, di erentiate this expression with respect tax. But if X
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variablename= ' variablename

(For example,x = 'X' to unassign the variablex.) Notice that both the quote symbols
here areforward quote
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2.3 Expressions and Functions.

It is important in Maple that you distinguish between expressions and functions .
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as well as, for example:

Function Description Example

abs absolute value abs(-2);

sqrt square root sqrt(4);

ifactor factorise integers (can take a long time) ifactor(12);

igcd greatest common divisor of integers igcd(6,8);

ilcm least common multiple of integers ilcm(6,8);

max maximum of a sequence of numbers  max(132,129,66,120);
min minimum of a sequence of numbers min(132,129,66,120);
binomial binomial coe cient binomial(4,2);

round round (up/down) to an integer

1 [
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However, iff has been de ned to be arexpressionin the variable x (for example by
f ;= x A2-x; ), you CANNOT get the value of f whenXx is 3 by writing f(3) sincef
is not a function. In this situation there are two methods which you can use to evaluate
f for a particular value of X, the rst being the preferred one:

1. Use the commandsubs to substitute for X as in
subs(x=3,T);

Note that this does NOT change the value ok or f | it simply displays the value
that f would have ifx were equal to 3. In this cas& remains an unassigned variable
and f remains an expression dependent oa

In general, the command
subs(expressionl= expression2 expressiony

will substitute expression2for expressionl everywhere that expressionlappears
EXPLICITLY in expression3 For example,

subs(m=e/c"2,f=m*a);

gives the resultf = ae=¢.

Several substitutions can be done in the one command. For example,
subs(a=2*d,d=b/c,a*b*c);

will substitute 2*d for a and then substitute b/ for d, giving the result 27 .

2. Assign the desired value tx and then ask Maple to displayf. For example, the
sequence of commands

T = x"2-x;
X = 3;
T;

will nally display the value 6, which is the value of x> x when x = 3. If you
want the value off at a second value ok, just assign the second value tx and
then displayf again. If you want to return f to being an expression in the unknown
X then you will have to unassigrx by one of the methods described in secti¢n 2.2.3.

2.3.3 Simplifying an Expression.

Maple often leaves an expression in a complicated form rather than in its “simplest'’
form. To remedy this situation, Maple provides a number of procedures which you can
use in an attempt to get an expression into a form which suits you better. Nevertheless,
you have to bear in mind that factorising and simplifying expressions (other than very
easy ones such as those in high school) isrery di cult process, both for humans and
for the computer, and it is not always clear what “simplify’ means. Consequently, you
may have trouble getting Maple to produce whatyou consider to be the nicest form of
an expression. This is probably the most frustrating part of using a computer algebra
package.

The following is a list of some of the commands you can try if you want to “simplify'
an expression. The descriptions given here are only brief, and in each case you should use
Maple's Help to nd out more about these commands.
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normal
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2.3.4 De ning functions with the arrow operator.

The arrow operator is used to de ne functions. For example, the functiori which

acts asf (x) = x2 x is de ned by
T = x -> x"2-x;

Here we use an arrow (typed as a immediately followed by >) to show that the

function replaces the (dummy) variablex by the expressiorx”*2-x. Then the command
f(3);

will display 6, which is the value off whenx is equal to 3, and you can writef(2*a-1)

for the value off whenx is equalto 2 1.

Note that the X which occurs in the de nition of f is adummy variable and hasno
relation to any variablex which might occur anywhere else in your Maple session. It just
provides a way of specifying a formula for the function.

You can usef(x) in any situation where Maple will accept an expression in the
unknown X. You can also usd on its own to represent the function in some situations,
but you must make sure that the situation is one in which this applies. For example, you
can di erentiate a function using the D operator (see sectiof 2.4.2) or use a function to
de ne a Matrix or Vector (see sectior] 2.10}4).

In MATH1231/1241 you will study functions of more than one variable. These can
also be de ned with the arrow operator. For example,

d := (X,y¥,z) -> sqrt(x"2+y"2+z"2); 0
is a de nition of the 3-dimensional distance function d(x;y;z) = X2+ y2+ z2,

Exercise Enter the above de nition of the function f .
What happens when you now enter

f;

eval (T);
2.4 Elementary Calculus.
2.4.1 Limits

To nd the limit of an expression as a variable tends to a value, use

limit( expressionvariable=value);
For example, to nd the limit of (sin x)=x asx! 0, type

limit( sin(X)/x, x=0 );
You can useinfinity  as a value if you want to nd the limitas x ! 1
For example, to nd the limit of (1+1=x)* asx!1 |, type

limit( (1+1/x)"™x, x=infinity );
You can ask for a one-sided limit by insertingleft or right . For example, to get the
limit of 1=x as x! 0", try using

limit( 1/x, x=0, right );

Note that the resultis 1 . In this case the lefthand limit gives the result 1 and
the two-sided limit gives the resultunde ned.

2.4.2 First Derivatives

To di erentiate an expressionwith respect to a variable, use

diff( expressionvariable);
For example, to di erentiate e sinx? with respect to x, you can enter
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y = exp(X)*sin(x*2); diff(y,x);
or just

diff( exp(X)*sin(x*2),x );
Remember that you should only di erentiate with respect to anunassignedvariable.
There are two ways to di erentiate a
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(with or without spaces before and after theb) to stand for the sequence consisting of
expressionrepeatednumber times. To di erentiate an expressionn times with respect
to x, you can enter

diff( expressionx$n );

To nd a higher derivative, for example the third derivative, of a function f of one
variable using theD operator use

D[1,1,1](F);
This notation looks a little odd, but will make more sense once you learn about patrtial
derivatives in MATH1231/1241 (se¢ 2.14).

2.4.5 Implicit Differentiation

If y related to x by an equation that de nes y as a function of x, then Maple can
use implicit di erentiation , to nd the derivative of y with respect to x with the
Maple command implicitdiff
For example, to nd the slope of (a tangent to) the circle x>+ y> =1, use

implicitdiff(x"2+y"2=1,y,X);
2.4.6 Maxima and Minima

To nd the global minimum value over the whole real line for an expression in one

unknown X, use
minimize( expression;
Use maximize to nd the global maximum.

You can also use these commands to nd global maximum and minimum values for
expressions in several unknowns. For example, to nd the smallest value (over all real
values of x and y) of x2+2x + y?, try using

minimize( xX"2 + 2*x + y"2 );
(You should get the answer 1, as you can see by completing the square.)

2.4.7 Integration
To nd an inde nite integral of an expression with respect to a variable, use

int( expressionvariable);
For example,
T = x"2*sin(x);
int(f,x);
or just
int( x*"2*sin(x),x );
Note that Maple does NOT show an arbitrary constantC in an inde nite integral.
If f is afunction, then you need to put theexpressionf(x) in the int command,
not just f.
You can nd a de nite integral
YA b

a
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If you have a variable whose value is aequencgtake care that you do not use it as
the argument of a Maple function that expects a single object. For example, if you apply
evalf to a sequencawvith more than 2 values, you will get an error.

If you want to give Maple a sequence that can be described by a formula, use the
commandsSe(. For example, the command

seq( n*(n+l), n=1..5);

generates the nite sequence ;5; 12,20, 30.

Sequences are used to construction several other types of objects in Maple, for example,
sets and lists. We will also use them to enter Vectors and Matrices (section 2.10).

2.5.2 Sets and Lists

A Maple list is a maple sequence enclosed in square brackets argktis a sequence
enclosed in a curly brackets. For examplef1,2,3] is a list and {1,2,3} is a set.
Maple treats a list or a set as a single object.

The important di erences between sets and lists are

The order in which the things appear isnot signi cant for sets but it is signi cant

for lists. Thus the sets{1,2,3 } and {3,2,1 } are treated as thesameset but the
lists [1,2,3] and [3,2,1] are dierent. Of course the contents of a set will be
printed in some particular order when Maple displays it, but this order is decided by
Maple and may not be the same as the order you entered. Maple keeps the order of
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op(L);
gives a sequence with the same values 8¢ This is useful if you want to add someting
at the end of the list. For example, you can change the value of the variablefrom the
list [1,2] to the list [1,2,3] by

L :=[ op(L), 3 1];

The commandop will also convert any expression into a sequence. This is because
algebraically any expression consists of asperator acting on a sequence of “parts’ or
operands, and op extracts the sequence of those operands. For example, the command

op(6*(xty)/z);
gives the sequence 6x + Yy, 1=z since 6k + y)=z is the product of 6, (X + y) and
1=z. There is a problem in that it is not always easy to tell what Maple will regard as
the operator. For example, Maple regardd/z as the power of z to the -1, and so
op(1/2);

gives the sequence, 1.

2.5.4 Selecting Operands

The commandop is actually quite a powerful general procedure for selecting operands
in many contexts, but its full description is a bit too advanced for inclusion here (for full
details, use Maple's Help). One use is that ifi has a positive integer value then

op(n, expression;
selects thenth operand of the expression. For example, the command

op(2,1/2);

gives 1 (see the example above).

In special cases there are synonyms fap such as:

numer and denomgive the numerator and denominator of a quotient expression.
For example,

numer( sin(x)/(1+cos(x)) );

gives the result sink).

coeff picks out the coecient of a specied power of a variable in a polynomial.
For example,

coeff( polynomial,x,5 );
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sort can also be used to put the terms of a polynomial intdecreasingpower order.
For example,

sort(1+x+x"6-x"3);
will give the result x®
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To get a sum to in nity, use infinity  as the upper limit. For example, try
sum(1/k"2,k=1..infinity);
If f is a function, you will need to writef(k) in the command (not justf).

You can use similar methods to evaluate products such as

o
f (K):

k=m
Just useproduct instead of sum.

Note that there will be many cases where Maple cannot nd a simple expression for
the answer and it may just return your question as its answer. For example, try asking
Maple to nd

X
T
- k2Ink

Maple also has the commanadd and mul, which should be used in certain situations

in place ofsumand product | see Maple's help pages.

2.6 Equations.

In Maple an expression of the form

leftside = rightside ;
is an equation . Note that in this case the= symbol is usedalone and not with the :
which appears in assignment commands. Make sure that you do not confuse equations
with assignment commands.

Maple allows you to perform various operations on equations. You can add two equa-
tions, or multiply an equation by a constant, or add a constant to it (i.e. to both sides of
it). You can use this to solve simple simultaneous equations. For example,

> el = 2*x+y=b: # el 1s the first equation
> e2 = X-y=4: # e2 1s the second7111 Tf -156.196 -25.5
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2.6.1 Solving Equations.

Maple provides two basic commands for solving equationssolve and fsolve .
In general, neither of these procedures tries to ndll solutions to an equation. However,
both of them will try to nd all real solutions to a polynomial equation.

If you give one of these solvers aaxpressioninstead of an equation, it will assume
that you want to solve the equationexpression = 0 .

Using solve
This tries to nd exact solutions to an equation or set of equations. For example, to
solve X +4=5x, use
solve( 3*x+4=5*x );
which gives the answer 2.
If the equation involves more than one variable, you will have to tell Maple which
variable to solve for. For example,
solve( a*x"2+b*x+c, X );
Notice that in this case we gavesolve an expression rather than an equation and Maple
will assume that we want to solve the equatiorax? + bx+ ¢

]
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When usingsolve
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The simplest way to get Maple to draw a graph is a using a command like

plot( expressionvariable=start.. end);
In this case Maple will decide the appropriate vertical scale. If you want to specify
minimum and maximum values on the vertical scale, use

plot( expressionvariable=start.. end, min.. max);
Note that there must be exactly TWO full stops betweerstart and end and betweenmin
and max. (This notation is used whenever you refer to ange of values in Maple.)
This command will plot the expressionfor values of thevariable
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for getting approximate coordinates for a point of intersection of two graphs or the
intercepts of a graph.

Note: As Maple scales each axis di erently, it may give a misleading impression of the
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you should rst construct a list of the coordinate pairs x1,y1], [x2,y2], ..., [xn,yn]
and then plot this list. (For details on lists, see sectiof 25.) For example,

datapoints := [ [1,sin(1D)], [2,sin(2)], [3,sin(3)], [4,sin(4)],
[5,sin(5)], [6,sin(6)], [7,sin(7)], [8,sin(8)] 1;

or (see sectiof 2|5 for theeq command)
datapoints := [seq([1,sin(1)],1=1..8)];
Note the use ofsquare brackets here. The square brackets ifiL,sin(1)]  etc. are
to indicate the coordinates of a point in thex;y -plane (an ordered pair of numbers |
i.e. a list with two members). The outermost square brackets are to make the sequence
of coordinate pairs into a list.
When you have created the list of coordinate pairs, execute the plot by

plot(datapoints);

2.8.3 Parametric Plots
To plot a curve de ned by
(x;y) = (ft;gt)

for t from a to b whenft and gt are expressions depending ob, use

plot( [ft,gt,t=a..b] );
Note the use ofsquare bracketd ] here. For example, try plotting a cusp with

plot( [t"2,t"3,t=-5_.5] );
or try plotting a circle with

plot( [cos(t),sin(t),t=0..2*Pi] );
where cos() and sin(t) are expressions made up using thfenctions cos and sin.

2.8.4 Polar and Implicit Plots
The packageplots provides special plotting procedures. Once you have loaded the
package by doing
with(plots):
you can usepolarplot  for polar curves andmplicitplot for implictly de ned curves.

Figure[2.2 is a plot of the the cardioidr =1 cos for from 0 to 2 done using

the command
polarplot(1-cos(t),t=0..2*Pi);

For convenience, we have used as the name for the variable representing | we do
not have to name ittheta .

You can plot the same curve in a parametric format as

polarplot( [1-cos(t),t,t=0..2*P1] );

and you can plot several polar curves on the same diagram by using curly brackets in the
same way as for the commanglot .

Try plotting the implicitly de ned ellipse x?+ y>=4 =1 to true scale by
implicitplot(x N2+y"2/4=1 x=-3..3,y=-3..3,scaling=CONSTRAINED);

where thescaling=CONSTRAINE®rces Maple to use the same scale on the two axes
(otherwise the graph looks like a circle).



2.9. The student
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evaluate it. This is an example of what is called amert procedure Maple also provides
the inert proceduresDiff , Limit , Sumand Product for entering derivatives, limits,
sums and products.

After you have entered an expression with one of these commands and applied various
procedures to the expression, you can nally evaluate it with the commandalue , as in

value(%);
Note that value only works with Int , Diff , Limit , Sumand Product.

2.9.2 Change of Variable

To change the variable in an integral (i.e. to apply the method of integration by
substitution) use the commandchangevar. The general form of this command is
changevar(s,F,u);
where

U is the new variable which is being introduced

S is an equation of the mathematical formh(x) = g(u) which implicitly or explicitly
de nes the old variable x in terms of the new variableu

F is an expression likdnt(f,x)  or Int(f,x=a..b) whenf is an expression irx;
or Int(f(x),x) or Int(f(x),x=a..b) whenf is a function.
The result of the command is an expression fér with the variable changed. For example,
changevar( 1+x"2=u, Int(x/(1+x"2),x=a..b), u );

Z1+b2 1

— du:
1+ a2 2U

If you use value to evaluate an inde nite integral in terms of u then you cannot
always usechangevar in the reverse direction to get the answer in terms of. You may
have to usesubs to substitute for u in terms of X (see sectiof 2.3]2).

2.9.3 Integration by Parts

This is integration by means of the formula
Z Z

udv = uv v du:

The general form of the command is

intparts(F,u);
whereu is the expression which is to play the role ofi in the above formula andF is of
the form Int(u* expressionx) .

For example, to integrate x3sinx with u= x3 try
intparts( Int(x*3*sin(x),x), x"3 );
2.9.4 Riemann Sums and Simpson's Rule
The student package o ers you the opportunity to calculate some Riemann sums
and get pictures showing the graph of the integrand together with the rectangles whose
areas make up the Riemann sum. It can also show sums corresponding to approximations
given by Simpson's Rule.
The command
rightsum( expresssiorx=a..b,n);
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will give you a summation expression for the Riemann sum obtained by dividing the
interval from a
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You create a Matrix using pairs of angle brackets (or thélatrix procedure). You
enclose the columns of the Matrix as a collection &fectors , separated by vertical lines
| and linked together with an outer set of angle brackets. For example, you can assign

the matrix
2

w .
S Qo

1
2

to the variable A with the command
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v :=[1,2,-4,9];
then v[3] will have the value 4 because the third entry in the listis 4. Note that
the same notation also works for lists.
You can use these notations in commands tthangethe value of entries. For example,
the commands
v[2] := 12: A[2,1] := 13:
will assign the value 12 to the second entry of the list and the value 13 to the entry in
the second row and rst column of the Matrix A
You can do the same thing with a set, but this is dangerous because the order of
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v = Column(A,2);
We also haveRowfor rows | but this creates a row Vector , which is not something
we'll be dealing with.
If you use a range (for exampl&..3 ) you can extract more than one column (as a
sequence).
Note that the things created by Column(and Row are Vectors (or sequences of
Vectors) and not Matrices

Another procedure which selects parts of matrices BubMatrix . The command

SubMatrix( A, a..b, c..d );
(wherea..b andc..d arerangesof positive integers) produces a smaller Matrix whose
entries are the values oA[i,j] fora 1 bandc | d, arranged in the same relative
positions as they had inA
You can also uséSubMatrix in the form
SubMatrix( A, [1,4..6], [2-.4] );
to get the submatrix whose entries are the values &[i,j]  fori in the list [1,4,5,6]
andj in the list [2,3,4]
Maple also let's you de ne Vectors and Matrices using amdexing function If f is
a function that takes one argument, Vector(5, T) gives a vector with the 5 entries,
f@), (2, f(3), f(4), f(5). Similarly, if g is a function that takes two arguments,
Matrix(2, 3, Q) produces a Matrix with 2 rows and 3 columns in which the element
inthe i™ row and j " column is given by g(i;j ). See sectiol for examples.

2.11 Gaussian Elimination.

The LinearAlgebra package provides the procedurRowOperation which allows
you to solve systems of simultaneous linear equations by going step by step through the
steps of Gaussian elimination. The one procedure will do di erent things, depending on
what arguments you give it. So:

<A | b> augment Matrix A by Vector b to give (A]b)
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then you could proceed as follows. (Note that some of the command lines end in a colon.
This is to save space by suppressing display of the result.)

> with(LinearAlgebra):

> A 1= <<0,2,1> | <1,-1,2> |< 2,-2,4> | <1,1,0> >:
>b :=<1,-1,5 >:
>ml :=<A | b>;
2
01 2 1 1
ml=42 1 21 1
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> reduced := RowOperation( m8,1,1/2 );

2
1 000 1
reduced =40 1 2 0 25
0001 1

We now have the fully reduced form and we can read o the general solution as
L2 2;; 1]

where is an arbitrary parameter representing an arbitrary choice of the third variable.

When Maple is solving systems of linear equations, it uses names lika, _t, for
arbitrary parameters which may occur in the general solution. So the solution of the
above set of equations would be displayed as

[1,2 2ty;_
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2. Maple can solve linear sytems with unknown parameters in them. In particular, it
can solve systems in which each of the entries in the righthand side is @amassigned
variable, for example

b:=<Dbl, b2, b3 >;

3. Ifyou are doingMATH 1231 orMATH 1241, you should look up the Maple help les
for the proceduresRank RowSpaceColumnSpaceTranspose, Determinant ,
Eigenvalues , Eigenvectors , CharacteristicPolynomial . To anyone who
has studied the linear algebra section oMATH 1231/1241, the e ects of these
procedures should be obvious from their names.

2.12 Vector and Matrix Arithmetic

The last section shows how to create and display Vectors and Matrices. However, we
cannot do any useful linear algebra without rst loading theLinearAlgebra package,
which provides many procedures for dealing with Vectors, Matrices and linear equations.
(Technically, LinearAlgebra is called amodule , but you can ignore this distinction.)

In these Notes we will only give an outline of some of the basic procedures. To nd out
more about these and other procedures available irinearAlgebra , use Maple's Help.

To use the procedures in this package, it is easiest to rst load it with the command

with(LinearAlgebra):
Note the use of thecolon here, which supresses the (very long) list of new funcitons in
LinearAlgebra .

However, you can use a command directly by giving itaill name : you do this by
adding LinearAlgebra:- to the start of the command. This is what Maple will do if
you operate with the context sensitive menus (see section 1.3.4).

Vectors and Matrices can be added, subtracted and multipled by scalars using the
usual operators+, - and *. Two Matrices can be multipled using the. operator. The

operator is also used to give the dot product of two Vectors. A square Matrix can be
raised to an integer power using'.

For example, to nd the linear combination 2/ 3w of the vectorsv and w we use

2*v - 3*w;
and we can enter the formula for a general point on the line through the points with
position vectorsv and w (i.e. the formula x = (1 )v+ w, where is an arbitrary
parameter). We do this by

X := (1-lambda)*v + lambda*w;

Note that A"(-1) gives the inverse matrix.

When using these operations, you must of course ensure that the Matrices and Vectors
are of the appropriate dimensions and, in the case of the negative power of a matrix, that
the matrix is invertible.

If you enter an expression involving these operations, Maple will automatically carry
out the operations. For example, to enter the mathematical expressiofAx + b, we use

AX + b ;
If values have already been assigned & X and b then A.x+b will be evaluated, but if
some of these variables are unassigned then you will get an answer involving the unassigned
variables.
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A useful convention in Maple is that, in expressions involving matrices, a scalar con-
stant can be treated as that scalar multiple of an appropriate identity matrix| . For
example, ifAis a square matrix then the command

1+ A+ 2%AN2
evaluates the polynomial expressionn + A + 2A?, where | is the appropriate identity
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by giving a cartesian equation for it or three (non-collinear) points on it or a point on
it and a normal direction or a point on it and two lines parallel to it. The command
sphere is used to assign a name to a sphere. A sphere may be speci ed by giving its
cartesian equation or four points on it or the end-points of a diameter or its center and its
radius. To display the speci cations of one of these things you need to udetail (see
the example below). For a plane, the detail includes a cartesian equation for the plane.
If you want to nd a normal to a plane p use

NormalVector(p);

Be warned that if you specify a plane or sphere by means of an equation then Maple
will want you to specify the names of the variables which are associated with the three
axes. You can do this by listing them as a third argument to theplane or sphere
command, as in

plane(P,x+y+z=1,[x,y,z]);

If you leave out the[X,y,z] then Maple will, rather strangely, prompt you with the
requestenter the name of the x-axis , to which you reply X; , and similarly for
the other two axes. The semi-colons areompulsoryhere. Depending on the way Maple
is set up, this might be done using a pop-up dialogue box.

When you have set up objects of these types you can, for example, use the command
distance to nd the distance between two of them or the commandntersection
to nd the intersection of two of them or the commandFindAngle to nd the angle
between two of them (where appropriate).

You can also useEquation to nd a cartesian equation for a line, plane or sphere
and center for the center of a sphere anadoordinates to nd the coordinates of a
point.

Use the MapleHelp to nd out more about any of these commands and to nd out
about the many other commands available igeom3d

In the following example, we rst label the points A(0;1;2) and B(2;3;1) and the
line AB through A and B. Applying detail to AB shows that the direction of the
line is (2,2; 1) and the line can be expressed in parametric vector form as

01 0 1
0 2

x=@A +t@2A: t2R:
2 1

Then we assign the labelP to the plane through C(4;5;6) with normal (1;1;1) and
usedetail to ndthat P can be described by the cartesian equation

X+ y+ vows8 0 Td [5.244 1.9552 Tf 5.244 65ine
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and so on.

Notice that we use a colort to suppress the output of most of the commands because
the output would just be an echo of assigned names.

with(geom3d):

Warning, the name polar has been redefined
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2.14 Partial Derivatives

If f is an expressionwhich contains several unknowns (one of which i) then the

result of the command

diff(f,x);
is the partial derivative @f=@xSimilarly, the command

diff(f,x,x);
gives you the second order partial derivative with respect t&. If f is an expression in
unknownsx and y (and maybe other unknowns as well), the mixed second order partial
derivative @f=@y@xs given by

diff(f,x,y);

If f is afunction, then you need to use either of the two methods in secti¢pn 2.4.2. For
example, iff is a function of two variables, then the rst method becomes

diff(f(x,y).y);

In the second method, use thd operator followed by numbers in square brackets to
indicate the variable with respect to which you are di erentiating. For example, iff has
been de ned as a function of two variabels then

D[2]1(F);

gives you the partial derivative with respect to the second variable and

D[1,2](F);

gives you function of two variables given by the mixed second order partial derivative

@f (x;y)=@y@and
D[1,2](F)(3,-2);

gives the value of that mixed derivative evaluated at the point (3 2).

Note: All derivatives in Maple are partial derivatives and this is the reason why Maple
insists on a second argument for thdiff command.

2.15 Ordinary Differential Equations.

The proceduredsolve is used to solve ordinary di erential equations (ODEs). You
enter the ODE as an equation involving the function, say(X), dierentiated appro-
priately with respect to X. For example to solve (i.e. nd the general solution of)
y%+ y =sin x + x you would use

dsolve( diff(y(x),x)+ty(x)=sin(x)+x, y(x) );

and for the more complicated equation
xy®+ y(x*+Iny) =0

you would use

dsolve( x*diff(y(x),x)+y(x)*(x*2+In(y(x)))=0, y(x) );
and to solve
y0 240 3y =2x
you would use
dsolve( diff(y(x),x,x)-2*diff(y(x),x)-3*y(x)=2*x, y(X) );

In the resulting general solutions, arbitrary constants are shown asC1 CZ2etc.
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NOTES:

1. The dependent variabley(x) must always be written completely ag/(X) and never
just as'y
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will nd the rst eight terms (i.e. up to and including the term of degree 7) in the Taylor
series about the pointx = 5 (i.e. in powers of & 3)) for the the function e * sinx
and it will assign the result to the variables.

Note that Taylor series arenot polynomials and cannot be treated as such, hence
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Only one assumption at a time can be made usirgssume If you useassumetwice
on the same variable then the rst assumption is lost. However, you can make additional
assumptions with the commandadditionally . It is used in the same way asissume

To nd out what assumptions have been made about a variable, use

about(variable);
and Maple will display all assumptions about that variable.
For example, to assume that the variabl@ is a positive integer and check the assump-
tions on a and then evaluate the limit of e ® as x!1  you could say
assume(a, integer);
additionally(a>0);
about(a);
limit( exp(-a*x), x=infinity );
To show that a variable has had an assumption made about it, Maple puts-aafter the
variable name. For example, the variabl@ with an assumption having been made about
it will always be displayed and printed asa~. This sometimes looks like a, so take care
when reading the Maple output. There is no need for you to type the when using the
variable.
An assumption about a variable can be removed by unassigning the variable in any of
the ways described in sectiop 2.2.3.
There are other details about making assumptions, such as tessuming command,
and you can check the relevant help entries if you want to know more.

Exercise What happens when you enter
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2.19.2 The if —then construction

As an example, the following commands are a procedure to nd the absolute value of
a real number.

absval := proc(x)
iIf evalf(x)>=0 then
X,
else
-X;
end I1f;
end proc;

The general shape of théf command is something like

I T condition1 then
commseql
elif condition2 then
commseqz2
el 1T condition3 then
commseq3
else commseqg4
end i1f:
where commseqletc are sequences of commands (each nishing as usual withor ;)
and conditionl etc are conditions that are tested for their truth. The action of such an
if command is to test ifconditionl is true and if it is true then execute (carry out) the
commands incommseqlwhile if it is not true then Maple tests condition2. If this is true
then Maple executexommseq2and if it is not true then Maple tests condition3. If this is
true then Maple executesommseqg3and if it is not true then Maple executescommseg4
An if command needs the rstif and then and the nal end if , but the other
parts are optional, depending on what is required. We have seen this above and there are
further examples in section 2.21]1.
You do not have to put : or ; after the then (though it will not matter if you do),
but you MUST put one after the end if .

2.20 Looping with for and while

Suppose that you want to execute a set of Maple commands several times, changing
the value of one variablen at each repetition. This is called creating doop, and is very
common in scienti ¢ programming.

The way you create the loop depends on whether you know in advance exactly how
may times you want to repeat the commands or not. If you know that you want to repeat
the commands 100 times then you can use a construction of the typ@r n from 1
to 100 do :::'. If you do not know how many repetitions you want to make then you
will have to tell Maple to keep repeating until some condition is no longer satis ed, using
a construction of the type while ::: do :::'

As an example of the rst type of situation, consider the following piece of Maple.
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for n from 0 by 2 to 4 do
print(“(atb) to the power®,n, “equals‘,expand((atb)”n));
end do:

The resulting display will be

(a+ b) to the power, 0O, equals, 1
(a+ b) to the power, 2, equals,a? + 2ab+ b?

(a+ b) to the power, 4, equals,a* + 4ab+ 6a%? + 4ab’ + b

This display shows the expansion ofa(+ b" for each of the valuesn = 0, 2 and
4. We terminate this “for{loop' with end do:, using a : rather than a ;, so that any
intermediate results will not be printed on the screen. We use thprint procedure to
force display of the things that we want to see. In the argument to thprint procedure,
text contained between back-quotes will be echoed in the printout and variables which
occur outside back-quotes will have their values printed.

It is possible to print things nicely using a speci edformat . This is done using the
printf  procedure which works the same as it does in the C programming language. We
will not go into any details here | use Maple's Help if you want more details.

As an example of a situation where you need to usghile , here is a loop that nds
the rst value of n for which the sum

X q
k=1 k

is greater than 5.
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the condition is satis ed then the body of the loop is carried out. Note that this means
that in Maple it is possible for the body of the loop not to be run, unlike some other
computer languages in which a loop is always run at least once. Thenis increased by
the value ofstep. If its new value is less than or equal to that ofnish and the condition
is still satis ed then the body is carried out again. This process continues until the value
of n is greater than that of nish OR the condition becomes false (whichever is rst). At
this point the loop ends. The nal value of n is the rst of the values start, start+step,
start+2*step, ... that exceedsnish OR the rst of these values at which thecondition
is false (whichever is the lesser).

The start, stepand nish must have values that are numbers. If the value ddtepis
negative then the obvious changes to the above description must be made.

If the from start or the by step is omitted then a value ofl is assumed. If the
while condition is omitted, then it is assumed to always be true. If thdor variable
is omitted, then the loop is carried out for the speci ed number of times and exactly
the same unchanged sequence of commands is performed at each repetition. You can
leave out everything except thewhile ::: do ::: end do:, provided that you have
assigned an initial value to the variable occurring in the condition and that the value of
this variable is changed by commands in the body of the loop. For example, the following
commands apply the Euclidean algorithm to nd the greatest common divisor of 3960
and 3780.

:= 3960; b := 3780;

hiIe b<>0 do

r := amod b;

a = b;

b := r;

end do

int( gcd 1s“,a)

Take extreme care with looping because you can very easily set Maple o on an in nite
loop, or at least a very long loop that will take you past your time limit and completely
ruin your Maple session. ThéSTORutton does not always stop a loop.

The commandsbreak and next can be used infor loops to change the normal
procedure. If abreak is encountered, then that loop is immediately nished, and the
command after theend do
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rewrite these aswhile loops requires a bit of thought. The following two examples show
how to get around this.

Suppose you wish to nd the rst Fibonacci number that is larger than 1000. The
natural way to do this is to calculate each number, check to see that it is smaller than
1000, if not, then calculate the next one and repeat. But we cannot check the size of the
number at the end of a loop in Maple, only at the start. To get around this, we do the
following:

af0] := 0: a[1] := 1:

for n from 1 while a[n] <= 1000 do
a[n+l] := a[n]+a[n-1]

end do:

At the end of this loop a[n] will contain the rst Fibonacci number greater than
1000, which is 1597. Note that the colon after thend do supresses the printing of
the intermediate values. If you enterop(a) you will see a table with all the Fibonacci
numbers that were calculated.

As a second example, suppose you are trying to use Newton's method to nd the
square root of 5, starting from a guess of 2. The you would be calculating successive

. . 5 .
iterates x, using the formula Xp+; = Xp + < Suppose we decide to nd the rst

2 "
Xn With jXx, Xn 1j < 10 ©. This can be done as follows:
X[0] := 2: x[1] := evalf((x[0]+5/x[0])/2):
for n from 1 while abs(x[n]-x[n-1]) >= 10°(-6) do
x[n+l] := evalf((X[n]+5/x[n])/2);
end do:

What this loop does is succesively calculatg, as long as the di erencejx, X, 1j
is greater than or equal to 10%. Once it is is not, the loop nishes. So at the end of this
loop X[n] has the desired value.

2.21 Functions and Procedures.
2.21.1 Procedures.

The functions de ned by the arrow operator are a special case of a procedure. The
general form of a procedure is as follows.

procedurename = proc (variables)
command sequence
end proc:
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The procedure is used in the formprocedurenamd variables) and the value produced

[]



T = proc(n)
option remember:
iIT n=0 then return 0
elif n=1 then return 1
else return f(n-1)+f(n-2)
end 1f:
end proc:

Check that this gives the same value fof(7)

2.22. Common Mistakes

57
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2.23 Reading Files into Maple.

Suppose that you are running a Maple session and you wish to use a sequence of
commands in a le. There are two essentially di erent ways of doing this, each with a
di erent e ect.

1. If the commands in a Maple worksheet.(nW or Maple Input le (.mpl) le then
you canopen a new worksheet containing thetext of the commands by a method
similar to that for saving a Maple session given in sectign 1.4.

(a) Click on the secondbutton from the left in the tool bar (it looks like a half-open
folder): a dialogue box calledOpen will appear.

(b) Atthe bottom of this dialogue box, you will see a box labelledFiletype which
looks something similar to:

All Worksheets (mw, mws) r

(c) If you want to open a Maple Input le, click on the symbol and a menu
will appear. Clicking on the Maple Input line. If you want to open a .mw
le, ignore this step.

(d) The main part of the dialogue box will be a list of all the.mw(or .mpl) les
in your home directory. If the le is there then click on it and the name wiill
be transferred to the box beside the wordFile N ame.

(e) Otherwise, move the mouse pointer into that box and enter the name of the
le you want to read including the le extension

(f) Click on the word OK

(g) If you are opening a Maple Input le then all the commands are placed in one
execution group, which is generally unhelpful.

The commands in this new worksheet will not be executed unless you go through
them pressing<Enter> in each execution group. This method is good if you want
to modify the commands before executing them. Alternatively, seledExecute
from the Edit menu (seq 3]7) or click on theExecute Icon (three exclamation
marks).

2. If the le is a Maple Input le then the command
read( lename );

will execute the commands in your le and display the results in your Maple work-
sheet, but it will not display the text of the commands. If lename contains any
special characters it must be surrounded with back-quotesas in

read( “proc.mpl® );

The read command is usually used when you have de ned a procedure (or some-
thing that takes a lot of typing, like a matrix) which you want to use in more than

one Maple session (or more than once in a session) since the commands are executed
immediately each time theread command is used.

Warning: If you use aread command in a Maple command le that you
are submitting as an assignment, remember that you must submihe le that is
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read as well as the command le, otherwise we cannot process the submission for
marking. Remember thatread does not give you a copy of the commands it carries
out, only their results.

. It may happen that there are commands that you want taead in every time you
start a Maple session. You can do this automatically by putting the commands
in a le called .mapleinit in your home directory. This le will automatically

be read in at the start of each and every Maple session (including when you use
restart ).

Note: .mapleinit
.mapleinit






Chapter 3
MORE ON THE MAPLE GUI.

The Maple GUI (Graphical User Interface) was introduced in chapter|2, where some of
its features were described. In this appendix, we build on what was said there and give a
more complete treatment of Maple's features.

3.1 Maple's Default Settings

Maple is installed on all PCs (both Windows and Linux) in the School of Mathemat-
ics and Statistics labs. However, the default settings have been modi ed to simplify the
interface. If you buy your own copy of Maple for use at home, you are strongly encour-
aged to modify the settings of your copy to match those in the lab. This is because all
documentation provided in your course assumes you are using a Maple in the School's
labs and any Maple tests in our lab will use those settings.

The rst time you start Maple after installing it with the default settings you should
see a window like the one in Figurg 3.1.

Figure 3.1. Maple with default settings

61
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3.2 Maple Settings in the Labs

To modify the default Maple settings to match the lab settings, do the following:

Close the palette (the region of the left of the Maple window containing lots of wide
buttons). To close the palette, click on the triangle pointing left at the top of the
bar between the palette and the main document area of the Maple window.

From the Tools menu selectOptions::: .

{ Click on the Display tab and for the rst item called Input display select
Maple notation.

{ Click on the Interface tab and for the fourth item called Default format
for new worksheets selectWorksheet.

{ Click on the Apply Gobally button to save the new settings and close the
options window.

SelectMaple Help from the Help menu. Then click on the Help window'sView
menu and selecDisplay examples with 2D math (this needs to be turned o).

Close all Maple windows to save the changes you've made to the settings.

L]
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Figure 3.2: The Maple Window

These are collected inte@xecution groups consisting of lines of text and/or input com-
mands. When you pressEnter> with the cursor anywhere within an input region of an
execution group, all of the commands in that group are executed and their outputs are
placed at the end of the group. Each execution group is indicated by a left square bracket
[ and each region within an execution group is called garagraph .

Execution groups in a worksheet, or material irany Maple window, may also be
organised into expandablsections indicated by a grey triangles in front of their headings.
When you click the left mouse button on the triangle, an expanded section is collapsed
(hidden) and a collapsed section is expanded | there is one of each in gu@.z. We will
not discuss the creation of expandable sections in these Notes, but you will see them in
the Maple help pages, for example.

It is possible to have several worksheets open at the same time. Each worksheet can
be printed as a separate document (see sectipn|2.8), and has its own window manager
allowing you to raise, move or resize it. The worksheet which is “on top' (i.e. which has
been raised) is called thective worksheet.

3.5 The Menu Bar

The menu bar is at the top of the Maple window. Depending on what type of region
the cursor is, some of these menus will be greyed out. For example, et menu is
greyed out in gure[3.2, but if the cursor were over the plot of sim, it would become
active.
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LaTeX (.tex) which are processed by the mathematical wordprocesséigX (as an
example, these notes were prepared usirgX).

Maple Input (.mpl) which contain just input and text regions. This is useful if you
want to write Maple scripts that can the executed without using the GUI using just
the commandline version of Maple. This is not something that you will need to do
in any rst year mathematics course at UNSW.

Maplet (.maplet)  which produces les that be used without by the Mapleviewer. You
will not need this.

Maple Text (.txt) which is an ASCII form of the worksheet. It is meaningful to all
versions of Maple and humans and contains output. The di erent types of regions
are preserved as follows:
all lines in input regions are saved as lines starting with;
all lines inSedt[(gJiofsLar1sasead as lihasstarfithf{gH3-B32Bdiees3509 [Thekdb&mear
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all lines starting with # will be put into text regions;
all other lines will be ignored.

Warning: In all three cases above, the le is included in the new worksheet and
appears on the screen (possibly including output), BUT it has NOT been processed by
the Maple processor at this session: it is as though you entered it all using the editing
features. If you want to make corrections or changes rst, then you may need to go
through the whole text, pressing<Enter> on every command line (after making the
changes) as described in sectipn 1..7. If you want all the commands to be executed just
as they are, then click the Execute Icon (three exclamation marks).

Notes :

1. If you open a Maple Input File or a Maple Text le then all the commands are
placed in thesameexecution group. This is rather annoying.

2. A list of the most recently opened les will also appear on th&ile menu, if you
have ever used this feature. Clicking on the name opens the le.

Exercise
Restart Maple and open the leexercise.mw that you made in the last
exercise. Use the mouse pointer in the scroll bar to move around on the
screen. Note that the output regions are as you would expect. Move the
pointer to the last empty input region (i.e. the last empty line with a>)
and click the left mouse button to bring the screen| cursor to that point,
then type
C,
You do not get anything except for the unassigned value. Why? Well
you have not sent anything to the Maple processor yet. To do so, move the
cursor up to the top line (the a := command line) and pres<Enter>
on each line.
Leave this session on the screen for the next exercise.

Close. .. : Close the active worksheet or document.

If you select the appropriatedose... and have made any changes to the active
worksheet or document since the last time you saved it, Maple will ask you if you want
to save it before closing. Otherwise it will simply close it.

Print : Print the active worksheet.

When you selectPrint , a dialogue box will appear giving allowing you to print the
worksheet directly or to a le. There are tabs to change the appearance of the printout,
but we advise you to leave these alone. If you just click on print, then your worksheet is
printed on one of the lab printers (see the lab notes for details).

If you tick the Print to F__ile box, then a dialogue box will prompt you for a le name,
the default given beingout.ps | the _ps extension telling you it is a PostScript le.
You can then view this le with a postscript viewer. The le manager on the Linux PCs
in the lab knows how to open view this le. Note that you might nd the Export as PDF
option described above to be a more convenient way to “print to le'.



3.7. The Edit Menu 67

Print Preview

Gives you a preview of the worksheet to be printed before proceeding to the Print
Dialogue Box.
Exit : Terminate the Whole Maple Session.

If you selectExit , then Maple will close all worksheets and documents before termi-
nating the whole session. If you have made changes to any worksheet or document since
the last time you saved it, Maple will ask you if you want to save before closing.

3.7 The Hit Menu

This menu deals mainly with deleting or moving highlighted material using Maple's
clipboard. This clipboard is similar to (and uses) the mouse clipboard.

Highlighting Material :  Select All and Find ...

Material in a Maple window can be highlighted using the mouse in the usual way. You
can also highlight the whole of a worksheet by selecting the optidgselect All
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You candelete the wholeparagraph containing the cursor by selectindelete El-
ement Note that input and output regions in an execution group are separate paragraphs
and so deleting one of them in this way does not delete the other one.

It is also possible to remove the output regions from either all of the highlighted
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Recovering from an Error:  Undo result
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The 2D-Math options are discussed in sectidn 3]14.

Exercises Check that the Maple commands of the previous exercises are on the screen.

1. Move the cursor to the output region of the rst line. Insert a text region above it
by using the Paragraph option in the Edit menu. Enter

this is an example

(it will printed in black instead of red). Using <Enter> will give you a new line of
text, and you can continue adding comments.

2. Create an input region after the above execution group using thExecution
Qoup option in the | nsert menu. Now type in the comment

# this 1s an example

(it will printed in red) and press <Enter>. This puts you on the line
b := expand(%);

To add more lines of comments using, insert another input region and type in the
comment beginning with # etc.

Page Break

This puts a page break at the cursor. On the screen this looks like a line across the
workshet with the words \page break” in the middle, but when youprint the worksheet
a new page is taken at that point.

3.10 The Format Menu

The options in this menu are used to control the look of individual characters or
words, such as their type-face (font) or size, or the positioning of paragraphs within the
worksheet. We advise you not to get too involved with this menu at this stage. Note that
any change you make only refers to the highlighted text or the current paragraph, and
most8b327(thenb327(thenb327(raph,)-3s7(thenbal7.44446 Tume)-287(thad [(6 T,hm..gh)27(ted)]T
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General

The two interesting options here aréAutoSave and Kernel Mode .

If you tick the Enable AutoSave box then Maple will save your worksheet every 3
minutes (you can change the time gap if you wish). The le is saved as a Maple Worksheet,
but is not given the .mwextension, instead it is called something likdile_MAS.bck,
and is overwritten each time.

For Kernel Mode, the default is

[ ]
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Precision

This tab allows you to control the number of digits Maple uses in its calculations and
displays: it is similar to resetting the global variableDigits .
Security

This tab is for features you will not have any use for in rst year.

3.12 The Help Menu

We have already looked at the most important options in this menu in sectign 1.5.
To nd out about the rest, select the option \Using the Help System" under \Manuas,
Dictionary, and more" and follow the links which interest you.

3.13 Alternatives to Commonly Used Menu Options

There are two shorter alternatives to the menus for many commonly used commands,
one of which uses the mouse and one of which uses the keyboard.

3.13.1 The Tool Bar

Some of the options from the menus in the menu bar can be replaced by clicking the
left mouse button on one of the buttons in the tool bar. The STOP button is described
in section[1.3.8, and the rst 13 buttons are theNew, Open, Save, Print and Print
Preview
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1. Open the palette dock by clicking on the right pointing triangle in the left edge of
the worksheet.

2. Open the expression palette by clicking on the appropriate grey triangle
R
3. Click on the fdx symbol.

4. Type the expression you want to integrate, using the carét for a power and the
down arrow key to go back down.

5. Use the<Tab>key to move the the next part of the expression (the variable of
integration and type t.

6. Press<Enter>. There is no need for a colon or semi-colon.

There are a large number of palettes with various things you might wish to enter. If
you want to use them, then you may | it is even acceptable to use 2D Math notation in
the laboratory test if you wish

3.14.1 Symbol recognition

The top palette (which is open by default) is for symbol recognition. This allows you
to draw an approximation to a symbol and ask Maple to make a guess at what you mean.
Draw the symbol by holding down the left mouse button in the scratchpad and then click
on the right button to ask Maple to guess. The left button clears the scratchpad.






Appendix A
SUMMARY OF MAPLE COMMANDS.

General
<Ctrl>-F4 emergency exit
# indicates a comment
X indicates end of a command
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Algebra: Simpli cation
expand(expr) expand expression
combine(
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Calculus
diff( expr, vars) di erentiate expression with repect tovars
D(function) derivative of a function of one variable
D[n]( function) derivative of a function with respect to itsn" argument
D[ ny, n2, ...]( function) derivative respect to argumentn; then n,, ...
int( expr, var) integral of expr with respect to var

int( expr, var=lo.. hi)  de nite integral of expr for var from lo to hi
limit( expr, var=value limit of expr asvar approachesvalue

limit( expr, var=valug left) limit from the left

limit( expr, var=valug right) limit from the right

sum(expr, var=lo.. hi) sum of expr for var from lo to hi
product( expr, var=lo.. hi) product from lo to hi

Diff , Int , Limit , SumProduct inert versions

Other Calculus

taylor( function, var=value order) Taylor series aboutvar=value
convert( t-series polynom) convert a Taylor series to a polynomial
dsolve( ODE, y(x)) solve ODE in derivative of y(x)

dsolve( f ODE, conds, y(x)) solve ODE subiject to conditions like

y(0)=1, D(y)(0)=1

Student Calculus Package

with(student) load student calculus package

changevar( old-exp=new-expt inert-expr, new-van change of variables
value( inert-expr) evaluate an inert integral etc.

intparts( inert-int, u) integrate by parts

convert( integrand, parfrac, var) convert to partial fractions
rightbox( expr, var=lo.. hi, n)  Riemann sum plot

leftbox, middlebox similar

rightsum( expr, var=lo.. hi, n)  Riemann sum calculation

leftsum, middlesum similar

simpson(expr, var=lo.. hi, n) apply Simpson's rule

maximize( function) nd maximum value of function

minimize( function) nd minimum value of function

LinearAlgebra Package

with(LinearAlgebra): load LinearAlgebra Package
<sequence create a Vector

<Vectorl | Vector2 | ...> create a Matrix

<M1 orvl| M2 orv2| ..> augmented matrix (side by side)
<M1 orvl, M2 orv2, ..> stacked matrix (on top of each other)
Vector| i] i" element of vector

Matrix [ i, j] (i,j) " element of matrix

RowMatrix, i) ith
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parametric, 34
polar, 34

D, 22, 48
defaults, 62
de ning functions
arrow, 21
as procedures, 55
denominator, 26
common, 20
rationalising, 20
dependent variable, 17
derivative, 21
higher order, 22
partial, 47
Determinant, 43
dialogue box, 3

dictionary, 9
Di, 36
di

in Maple, 21
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general solution, 42
geoma3d, 44
geometry, 44

3D, 44
graphs, 31

intersections of, 33
greatest common divisors, 49
GUI

Maple, 61

help
Maple, 9
Help Browser, 9
Help Navigator, 9
hyperbolic functions, 17

i (square root of 1), 15
identity matrix, 39, 44

if - then, 52

imaginary part, 31






partial fractions, 24
percent, 5
, 15
piecewise functions, 33
plane, 45
plot, 32
buttons, 32
scaling, 33
plot3d, 35
plots
3D, 35
comparing, 33
implicit, 34
package, 34
parametric, 34
polar, 34
plotting, 31
point, 45
polarplot, 34
polynomial, 26
characteristic, 43
sorting, 27
Taylor, 49
Power, 49
precedence, 13
prettyprint, 71
prime numbers, 51
principal value, 31
print, 53, 56
printf, 53
printing
graphs, 33
problems
common Maple, 57
procedure, 55
inert, 35, 49
recursive, 56
Product, 36
product, 28
cross, 44
dot, 44
properties, 50
punctuation, 57

radicals, 20
radsimp, 20, 50
range, 30, 32

INDEX

rank, 43
rational functions, 20
reading in les, 58
real part, 31
recalculation, 57
recurrence relations, 50
regions, 4
remainder, 49
remember, 57
repetition, 22, 25
reserved names, 15
restart, 16
restart icon, 72
result

last, 5
return, 56
rhs, 26
Riemann sum, 36
rightbox, 36
righthand side, 26
rightsum, 36
root, general, 30
RootOf, 30, 31
round, 18
row operations, 40
RowOperation, 40
RowSpace, 43
rref, 42
rsolve, 50

scalar constants, 44
scaling, 34
sec, 17
sech, 17
section
expandable, 63
selecting, 26
from Matrices, 38
from sets and lists, 38
from Vectors, 38
operands, 26
seq, 25, 34
sequence, 24
of repetitions, 22
series, Taylor, 48
set, 24
set algebra, 49
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sets, 25
signi cant digits, 14
simplify, 20
Simpson's Rule, 36
sin, 17
sinh, 17
solutions
checking, 29
complex, 27, 30
exact, 29
oating point, 30
general, 42
not nding, 30
ranges for, 30
selecting, 27
simplifying, 31
to linear equations, 42
solve, 29
solving, 29
di erence equations, 50
di erential equations, 47
polynomial equations, 29
recurrence relations, 50
several equations, 29
simultaneous linear equations, 40
sort
in Maple, 26
sorting
in Maple, 26
sphere, 45
square root, 18
structure, 24
student, 35
SubMatrix, 40
subs, 19
substituting, 19
in list, 27
in set, 27
Sum, 36
sum, 27
Riemann, 36
supressing output, 18, 41, 46, 53, 55
switches, 64
symbol recognition, 73

tan, 17
tanh, 17

Taylor polynomials, 49

Taylor series, 48
text region, 4
tick marks, 33
toggle, 64
Transpose, 43
trigonometric
expansions, 20
functions, 17
truncate, 18

unassign, 15
unassignment, 15

underline character, 15

unknown, 14

value, 14, 36, 37
principal, 31
returning, 56

variable, 14
change of, 36
dependent, 17
dummy, 21
independent, 17
names, 15

Vectors, 24, 37
arithmetic, 43

index functions, 37
operations on, 43
selecting entries, 38

warning

assigning values, 16

defaults, 70
functions, 17

reserved symbols, 38
using read command, 59

worksheets, 16
while, 52, 53
window

Maple, 2, 61
with, 18
worksheet

active, 63

Maple, 3, 4
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